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activities
Tours of the 1907 Victorian 

House at 202 W. 13th are from 1 to 
5 p.m. Wednesday through Mon-
day. Closed on Tuesday. 

The High Plains Museum, 1717 
Cherry Ave., is open from 9 a.m. 
to 5 p.m. Monday, Wednesday 
through Saturday and from 1 to 4 
p.m. Sunday. Closed Tuesdays.

The Carnegie Arts Center is 
open from 10 a.m. to 5 p.m. Tues-
day through Saturday, 1 to 4 p.m. 
on Sunday and 1 to 6 p.m. on 
Monday at 120 W. 12th. The center 
is always in need of hosts and host-
esses on Sundays. New monthly 
exhibits and you are invited to visit 
the gift shop.

The Goodland Public Library is 
open from 10 a.m. to 8 p.m. Mon-
day through Thursday and from 
10 a.m. to 5 p.m. Friday and Sat-
urday. For information call (785) 
899-5461 or stop by the library. 

The local High Plains Consti-
tutional Society will meet the first 
and third Tuesdays of each month 
from 7 to 8 p.m. at the Rock House, 
6th and Caldwell, Goodland. 

Big Brothers/Big Sisters of Sher-
man County is seeking mentors and 
children to mentor. Call 890-3665.

The Good Sam Family Support 
Council meets at 7 p.m. the first 
Thursday of every month at the 
Goodland Elks Lodge. Meetings 
are open to all interested people. 
For information call 890-3117 or 
890-5936.

Diabetes Support Group meets 
at 4 p.m. the last Tuesday of each 
month in the large board room at 
Goodland Regional Medical Center. 
Patients, family and friends meet 
each month for a speaker and edu-
cational program. Call Sarah Linton 
at 890-6044.

Breast Cancer Support Group 
meets at 5:30 p.m. the second 
Monday of the month. Any woman 
with cancer is welcome. Call Cheryl 
at 890-5528 for more information.

Cancer Support Group meets at 
6 p.m. on the third Thursday of each 
month at the Goodland Regional 
Medical in the large board room.  
Group open to any cancer patient, 
survivor, caregiver and family 
members. Call Tina Goodwin at 
(785) 890-6036.

Emotions Anonymous meets 
at 7:30 p.m. Wednesdays at the 
Goodland Regional Medical Center 
board room.

The Goodland Activities Center 
has the following activities. Mon-
day: 5:30 a.m. aerobics with Tena 
Tompkins and 5 p.m. taekwando. 
Tuesday: 5:30 a.m., workout with 
Grady Bonsall. Wednesday: 5:30 
a.m. aerobics with Tena Tompkins, 
9:45 a.m.  finding fitness class, 4 
p.m. taekwando classes and 5:30 
p.m. aerobics with Lisa Malsom. 
Thursday: 5:30 a.m., workout with 
Grady Bonsall and 9:45 a.m. find-
ing fitness class. Friday: 5:30 a.m. 
aerobics with Tena Tompkins and 
starting at 5 p.m. taekwondo classes. 
For information call 890-7242.

Weight Watchers meets at 5:30 
p.m. for weigh in and 6 p.m. for the 
meeting every Tuesday at the Right 
Combination Dance Studio, 902 W. 
Hwy. 24. For information call (785) 
890-3285.

Goodland Alcoholics Anony-
mous meets at 8 p.m. Monday, 
closed meeting, Wednesday, the 
book meeting, and Saturday, an 
open meeting, at 1013 Center. For 
Alcoholics Anonymous, call Pat T. 
at 890-3915 or Laura at 821-4277. 

Goodland Al-Anon Serenity 
Seekers group meets at 8 p.m. on 
Mondays at 1013 Center. Contact 
Cheryl at (785) 890-3023, Shelly 
at (785) 890-3915 or Twila at (785) 
332-2078 for more information.

Goodland Adult Children of 
Alcoholics meets at 6 p.m. on 
Fridays at First Christian Church, 
711 Arcade. For information call 
Alice or Marilyn at 890-5914 or 
821-2862.

The Incognito Group. If alcohol 
has made your life unmanage-
able and you find yourself power-
less. Our group meets at 7 p.m. on 
Tuesday, Thursday and Friday in 
Goodland. Talking about it is the 
first step. Call for our meeting place 
(303) 905-3817, (785) 728-7022 
and (785) 728-2120. Leave a mes-
sage and number and we will get 
back to you.

The “Freedom Today” group of 
Narcotics Anonymous meets at 8 
p.m. Tuesdays, 8 p.m. Fridays and 
8 p.m. on Sundays at 1013 Center. 
Call 890-8369.

Bird City Alcoholics Anony-
mous group meets at 6:30 p.m. 
(Mountain Time) on Fridays at the 
Senior Center on 4th Street. Nar-
cotics Anonymous meets at 6:30 
(Mountain Time) on Tuesdays at 
the Senior Center. Call (785) 734-
2734 for more information.

Stratton “AA by the Book” Al-
coholics Anonymous group meets 
at 7 p.m. Thursdays for a beginners 
open meeting. Families and young 
people welcome. Call (719) 348-
5398 for men and (719) 346-8553 
for women. On U.S. Highway 24 go 
to Statton and it is the second house 
on the left, 513 Iola Street.

Fibromyalgia and Chronic 
Myofascial Pain Support Group 
meets from 6:30 to 8:30 p.m. the 
third Wednesday of every month 
in the Emergency Medical Services 
building, 257 15th St., in Burling-
ton. Call Debbie at 719-346-4612.

area events
Prairie Museum of Art and 

History, 1905 S. Franklin, Colby is 
open from 9 a.m. to 5 p.m. Central 
Time Tuesday through Friday and 1 
to 5 p.m. Saturday and Sunday.

blue star banners
Do you have a son or daughter, 

grandson or granddaughter serving 
in the active duty military service? 
The Goodland Elks Lodge 1528 
would like to present you with a 
“blue star banner” for your window 

to show your pride! Please call the 
secretary at the Goodland Elks 
Lodge 1528 at (785) 890-6251 to 
visit with her about this?

thrift store
Anyone wanting to donate to the 

Goodland Churches Thrift Shop, 
1002 Main, should call 890-2007. 
The store is open 9 a.m. to noon 
and 1 to 5 p.m. on Tuesday through 
Friday and 10 a.m. to 4 p.m. on 
Saturday. 

health department
The Sherman County Health De-

partment at 1622 Broadway is open 
from 8 a.m. to noon and 1 to 5 p.m. 
Monday through Friday.

Blood pressures; infants’, chil-
dren’s and adult’s immunizations; 
health assessments for Kan Be 
Healthy, daycare and school entry; 
fasting blood sugar and hemoglo-
bin; and family planning available 
by appointment. Sharps containers 
are available free. WIC program 
available. Call 890-4888 or go to 
www.sherman.kansas.com. 

If you have questions, concerns 
or complaints about child care, call 
the health department.

Water Testing — The Northwest 
Local Environmental Protection 
Group does well evaluations, in-
cluding testing for bacteria and 
nitrates. To schedule an evaluation 
or discuss environmental concerns, 
call the Health Department at 890-
4888.

hospital volunteers
Gift shop hours are 9 a.m. to noon 

and 1 to 4 p.m.; a.m. and p.m. volun-
teers are in the gift shop. 

early head start
Early Head Start is a state fund-

ed program for income eligible 
families with prenatal mothers and 
children up to three. Families par-
ticipate in a variety of educational 
activities and receive free medical 
and dental care.

Services include special needs 
of children with disabilities. If you 
have a family member with a special 
problem, such as drug or alcohol 
abuse, job loss or other family crisis, 
your family can qualify. Call 785-
672-3125, ext. 187.

preschool

Sherman County Head Start is 
a free preschool for eligible 3 and 
4 year olds. The federally funded 
program is targeted to families who 
meet certain economic guidelines 
and provides hearing, vision, dental 
and educational screenings. Nutri-
tious meals are served, and parents 
are encouraged to get involved in 
their children’s education.

Families interested in having 
their child in the program should 
call Colleen Wagner at 890-2552 or 
go to Sherman County Head Start, 
823 W. 11th.

crimestoppers
If you have information about 

any crime, call the Goodland Area 
Crime Stoppers “Look Line” at 899-
5665. Your call will be confidential 
and you will not be asked your 
name. If the information results in 
the arrest and/or conviction of those 
involved, you could be eligible for 
a reward of up to $1,000. Goodland 
Area Crime Stoppers is a nonprofit 
organization formed by citizens 
against crime.

family shelter
The Northwest Kansas Domestic 

and Sexual Violence Services pro-
vides help day or night to victims 
of domestic violence and sexual 
assault. Weekly support groups are 
available in Hays. Support group 
for women’s domestic violence vic-
tims/survivors is from 3:30 to 4:30 
p.m. Central Time on Wednesdays; 
a men’s domestic violence victims/
survivors support group from noon 
to 1 p.m. Central Time Tuesdays; 
and a youth support group is avail-
able by appointment. A sexual 
violence victims/survivors sup-
port group in Hays and a domestic 
violence support group to meet in 
Colby are being formed. If inter-
ested in joining or for information 
or help, call (800) 794-4624. In the 
Colby area, cal(785) 443-1130 ask 
for Becky. For time and location of 
youth support group, ask for Jen-
nifer Follis.

animal shelter
Lost a pet? Call 890-4575 or go to 

www.petfinder.com and be sure to 
enter the Goodland zip code 67735.
You can also call the Goodland Po-
lice Department at 890-4570.

the calendar
calendar

Prairie Land Food will be 
distributed from 1:30 to 2:30 
p.m. on Saturday at the Knights 
of Columbus, 7th and Caldwell. 
For information call 821-1827 or 
821-1275 or order online at www.
prairielandfood.com. 

At 2:30 p.m. on Saturday 
Marci Penner will be at the High 
Plains Museum for a book signing 
of “8 Wonders of the World”and 
program by Marci Penner.

There will be a Goodland Com-
munity Blood Drive from noon 
to 6 p.m. on Tuesday, Sept. 27, at 
the Goodland Methodist Church 
Fellowship Hall, 12th and Sher-
man. Call 1-800-RED CROSS or 
visit redcrossblood.org to make 
your life-saving appointment 
today. Photo I.D. 

Prairie Land Food sign up 
will be until Monday, Oct. 10.  
Distribution is 1:30 to 2:30 p.m. on 
Saturday, Oct. 22, at the Knights 
of Columbus, 7th and Caldwell. 
For information call 821-1827 or 
821-1275 or order online at www.
prairielandfood.com. The Prairie 
Pak will have pork breakfast 
sausage, breaded chicken breast 
patties, lean ground beef, boneless 

pork chops, tray pack of chicken 
drums, fruits and vegetables. The 
specials are pizza party, seafood 
box, tour of Italy and all natural 
chicken box. The choice item is 
an apple crumb pie.

The annual mass flu shot clinic 
as an emergency preparedness 
exercise by the Sherman County 
Health Department will be from 2 
to 6 p.m. on Tuesday, Oct. 11, at 
the Elks Lodge, 

Tuesday Flicks are at 1:30 
p.m. at the Goodland Public 
Library, 812 Broadway. Call the 
library for the title of the movie at 
899-5461.

senior menu
Today: Chili, five cup salad, 

crackers and cinnamon roll. 
Wednesday: Oven fried chicken, 
mashed potatoes with gravy, 
green beans, bread, and peaches. 
Thursday: Cook’s choice entree, 
hash brown casserole, peas and 
carrots, bread and gelatin with 
fruit. Friday: Lasagna, broccoli/
cauliflower salad, cook’s choice 
fruit, garlic bread and pudding.

school menu
Today: Breakfast - biscuit and 

gravy, cereal, juice and milk. 

Lunch - Chicken sandwich with 
lettuce and pickle, potato wedge, 
half and apple and milk. Wednes-
day: Breakfast - Gramwich with 
fruit, cereal, juice and milk. Lunch 
- Pizza, lettuce salad, green beans, 
pudding and milk. Thursday: 
Breakfast - Toast with sausage, 
cereal, juice and milk. Lunch - Pig 
in a blanket, french fries, baked 
beans, gelatin and milk. Friday: 
Breakfast - Donuts with fruit, 
cereal, juice and milk. Lunch 
- Hamburger gravy, mashed po-
tatoes, beets, wheat roll, spiced 
pears and milk.

school calendar
Today: Black day. 3 p.m. junior 

high volleyball at triangular at 
Max Jones Fieldhouse. Wednes-
day: Gold day. Thursday: Black 
day. Central School Body Venture. 
2 p.m. junior high cross country at 
Ulysses. 2 p.m. girls varsity golf 
at Holcomb. 3 p.m. varsity and ju-
nior varsity volleyball at Ulysses. 
4 p.m. junior high football against 
Burlington. 4 p.m. junior high 
volleyball against Burlington. 
Friday: Gold day. 11:30 a.m. AFS 
Walk. 6:30 p.m. varsity football 
against Scott City.

obituary

See American Profile magazine in this week’s issue of
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Dale Taylor Carter

Carter

Dale Taylor Carter, 51, Avinger, 
Texas, brother of Tina (Bruce) 
Roe of Goodland, died 
Wednesday, Sept. 14, 
2011 at his home after an 
eight month battle with 
cancer.

He was born on Oct. 
16, 1959, to Robert Felix 
Carter and Mable Elender 
Pentico Carter at Good-
land.

Mr. Carter had three 
college degrees: a Bach-
elor of Arts in English, a 
Master of Science in Education and 
a Ph.D. in Bible Studies. He was a 
retired teacher, taught English and 
writing in the Texas public school 
system, charter schools and in the 
Texas Juvenile Justice System. He 
also taught continuing education 
classes at the college level for six 
years and was director of education 
at two driving schools and later be-
came an ordained and independent 
Evangelical minister.

He was involved in the Boy 

Scouts of America as a leader for 
over 30 years. Mr. Carter was an 

Eagle Scout and a member 
of the Order of the Arrow. 
He was also a member of 
the Sigma Tau Delta In-
ternational English Honor 
Society.

Preceding him in death 
were his parents and a son, 
Robert Dale Carter.

Survivors include his 
wife, Kathleen Carter of 
the home; three children, 
April Vasquez of Pensa-

cola, Fla., Daniel Carter of Mar-
shall, Texas and Breanna Carter of 
Avinger, Texas; two brothers, John 
Carter of Daingerfield, Texas and 
David Carter of Odessa, Texas; and 
father, Dale Taylor of Garden City.

Services were at 10 a.m. Saturday, 
Sept. 17, 2011, at the Capt. William 
Perry Chapel of Haggard Funeral 
Home, 203 E. Clarksville, Street, 
Jefferson, Texas with Daniel Hen-
son officiating.

A to Z tips to use
for Quickbooks

A – Add/Edit Multiple 
List Entries – Added in 
2010, Add/Edit Mul-
tiple List Entries is the 
fastest and easiest way 
to update lists.  You can 
find it in the Lists menu 
and watch a tutorial on 
its benefits.

B – Backup – Making regular 
backups is the best way to protect 
your data.

C – Class Tracking – By turning 
on class tracking in the account-
ing company preferences, you can 
track segments of your business 
and determine what areas are more 
profitable.

D – Ctrl+D – Lets you delete a 
transaction or list item that hasn’t 
been used.

E – Edit menu then Preferences – 
Numerous preference choices lets 
you control how you interact with 
QuickBooks.

F – Find (Ctrl+F) – Find helps 
you find whatever you want to find 
in QuickBooks.

G – GoPayment.com – GoPay-
ment allows you to accept credit 
card payments on your phone and 
download them into your Quick-
Books file.

H – Help (F1) – QuickBooks has 
a large help database to answer most 
of your questions.

I – Icon Bar – Make that icon bar 
your own by right clicking on it and 
selecting Customize Icon Bar.  You 
can also add items to your icon bar 
by opening a transaction window or 
report then click on the View menu 
and Add to Icon Bar.

J – Journal Entries – QuickBooks 
is transaction driven, so leave those 
dreaded journal entries to your ac-
countant.

K – Keep it simple! – QuickBooks 
is a user-friendly program.  Don’t 
over-complicate it.

L – Lists – QuickBooks lets you 
track lots of information in your 
lists – vendors list, customers list, 
etc.  Instead of keeping a separate 
address book, why not track it all in 
QuickBooks.

M – Merge – If you’ve acciden-
tally added a list entry twice, you 
can merge them into one and clean 
up that list.

N – Notes – QuickBooks lets you 
add notes to your customers and 
vendors.  Just open the Vendor or 
Customer Center and click on the 
Edit Notes button.

O – Open Windows List – Need a 
quick way to switch between open 
windows?  Click on the View menu 
then Open Windows List.  Which-
ever window you click on in the list 
comes to the top.

P – Product Information (F2) – 

The Product Information window 
shows you lots of helpful informa-
tion about your QuickBooks file.

Q – QuickReport – You can cre-
ate a QuickReport from lists and 
registers.  Simply select a list item 
or register transaction and press 
Ctrl+Q to open a report.

R – Report Center – Not sure what 
report will show you what you’re 
looking for?  The Report Center 
gives you report descriptions and 
sample images.

S – Shrink your file – Unfortu-
nately, the clean up data function 
doesn’t help much in shrinking your 
file.  The best way to shrink your file 
is to create a portable company file 
and then restore it.

T – T = Today – Pressing T while 
in any date field will change the date 
to today.

U – Unidatait.com – If you want 
your data file in the cloud but don’t 
like QuickBooks Online versions, 
Uni-Data offers QuickBooks host-
ing for reasonable monthly rates.

V – Void – If you want to void a 
transaction, simply open it, click 
on the Edit menu, and then void the 
transaction.

W – Workflow – The arrows on 
the homepage help direct you on the 
workflow in QuickBooks.  If you 
enter a bill, you need to pay the bill.  
If you create an invoice, you need 
to receive the payment, then record 
the deposit.  Failure to follow the 
workflow can result in overstated 
balances.

X – Ctrl+X = cut, Ctrl+C = copy, 
Ctrl+V = paste

Y – Ctrl+Y – Opens the transac-
tion journal and lets you see what 
will happen behind the scenes.

Z – QuickZoom – When you see 
that QuickZoom magnifying glass, 
you can double-click and bring up 
more detail about that item.

This tip was brought to you by 
Western Kansas Business Consult-
ing, sponsored in part by Sherman 
County. We offer free and confiden-
tial business consulting to Kearny, 
Scott, Sherman, and Wichita coun-
ties. For more information or to set 
up an appointment, contact Jamie 
Morphew at (620) 874-0771.

jamie 
morphew
• business tips

you can learn a lot
   from the Newspaper!

Encourage your children to 
make reading the newspaper 
a part of their everyday 
routine for lifelong learning. 
Newspapers are living 
textbooks, helping students 
develop reading, math, social 
studies and language skills 
while exploring the issues 
affecting our world today. 
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